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Chapter 3

Building Your First Report

After completing this chapter, you will be able to:

■ Use the Report Designer wizards to create a simple tabular report.

■ Publish a report solution.

■ Use Report Manager to manage report properties.

■ Use the HTML Viewer to access and export a report.

In Chapter 1, “Understanding Reporting,” you learned about the three stages of the reporting 
life cycle: authoring, managing, and accessing reports. In Chapter 2, “Installing Reporting 
Services,” you learned how to install and configure Reporting Services, so you should be ready 
to go exploring now. In this chapter, rather than review each component of Reporting Services 
in detail, you take a tour of it. You visit each stage of the reporting cycle as you build, manage, 
and review your first report, and you also learn about the key components of Reporting Services. 

You start your tour by authoring a simple report using wizards in the Report Designer, which will 
enable you to set up and design the report. You also use the Report Designer to polish and pub-
lish your report. Then, you move on to the management stage and use Report Manager to update 
the report’s description and execution properties. Finally, you wrap up your tour in the access 
stage by using Report Manager to explore the report online and to export it as a Microsoft Excel 
file. When finished, you wind up with a high-level understanding of the various components of 
Reporting Services and the way they work together to create a powerful reporting platform.

Authoring a Report
The process of authoring, or building, a report consists of several steps. The first step is to 
define a Reporting Services data source, which packages information about where the data to 
be used in your report is stored. To create a data source, you need to know which server hosts 
the data and which database or file stores the data, as well as have the credentials with permis-
sion to retrieve that data. Each report that you author must have at least one data source 
defined. Data sources are covered in more detail in Chapter 4, “Developing Basic Reports.”

The second step in building a report is to create a dataset for the report. An important compo-
nent of the dataset is a query, which requires that you know the language and syntax used to 
retrieve data. For example, if your report will use data from a Microsoft SQL Server database, 
you’ll need to be able to create a Transact-SQL query (or know someone who can write it for 
you!). A dataset also includes a pointer to the data source and other information that’s used 
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when the query executes. When you use the Report Server Project Wizard, as you will in this 
chapter, you can define only one dataset, but you’ll learn how to work with multiple datasets 
in a single report in Chapter 7, “Building Advanced Reports.”

The third and final step in the construction of your report is the creation of a report layout, 
which is the design template used by Reporting Services to arrange and format the data. The 
report layout includes the structure, or data region, into which data is placed when the report 
is processed, such as a table or matrix. You can set properties for each section of a data region 
to define style properties, such as font, color, and format. Additionally, you can set these prop-
erties for report items, such as the report title in a textbox or the report background, which 
gives you enormous flexibility to control the look and feel of your report.

In this chapter, you use the Report Server Project Wizard and the Report Wizard to help you 
start and build a new report. You’ll learn another way to begin a report in Chapter 4. These 
wizards, which are provided within the Report Designer, are handy tools that walk you 
through the three main steps of authoring a report. 

Starting a New Report

When you start a new report using the Report Server Project Wizard, you are creating 
Microsoft Visual Studio containers to hold your report, a project, and a solution. You must 
name these containers and provide a storage location for them on your computer’s hard drive 
or on a network file share.

In this procedure, you’ll create a new report project called Adventure Works and specify a stor-
age location for the project.

Start the Report Server Project Wizard

1. Start SQL Server Business Intelligence Development Studio.

Notice the title of the application is Microsoft Visual Studio. SQL Server Business 
Intelligence Development Studio is Visual Studio. You are simply using a shortcut 
from the Microsoft SQL Server 2005 program group to access Visual Studio.

2. On the File menu, point to New, and then click Project.

The New Project dialog box appears. Templates are organized by Project Type, repre-
sented as folders in this dialog box.

Note If this is your first time working with Visual Studio, you might not be familiar 
with the way that items are organized in this environment. A report is placed inside of a 
project, which you can think of as a folder that organizes many reports into a collection. 
Because you’re using the Report Server Project Wizard, you can work with only one 
project right now. However, you’ll be adding reports to this project as you progress 
through this book. When you publish all reports in a project, they are automatically 
organized into the same folder on the Report Server.
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3. Click Report Server Project Wizard.

4. Type a name for the project: Adventure Works.

Notice that as you type, the text in the Solution Name box of the New Project dialog box 
changes to match the project name. You have the option of changing the solution name 
later if you change your mind. 

Note In the same way that a project is a container for a report, a solution is a con-
tainer for one or more projects. Visual Studio lets you work with only one solution at a 
time, but you can access any project within the open solution. 

5. Type a location for the project: C:\Documents and Settings\<username>\My 
Documents\Microsoft Press\rs2005sbs\Workspace.

Important Be sure to replace the placeholder <username> with the name you use to 
log into your computer.

The New Project dialog box looks like this:

6. Click OK to continue.

The Welcome page of the Report Wizard is displayed. Note that this wizard is different 
from the Report Server Project Wizard. The Report Server Project Wizard lets you create 
a solution, a project, and a report in one step, and then launches the Report Wizard. You 
can use the Report Wizard any time you want to add a report to an existing project using 
a wizard interface. (This is explained in more detail in Chapter 4.)
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If you want to bypass this page of the Report Wizard in the future, you can select the 
check box here to disable the Welcome Page.

7. Click Next.

Connecting to a Data Source

The next step of the Report Wizard allows you to specify connection information. Here you 
identify the server and database hosting the data. If necessary, you can also supply credentials 
information to be used by Reporting Services for authentication when querying the database.

In this procedure, you’ll create a data source that defines a connection to the rs2005sbsDW 
database in your SQL Server using Microsoft Windows authentication. 

Select a data source

1. Type a name for the data source: rs2005sbsDW.

2. Select Microsoft SQL Server in the Type drop-down list, if necessary.

The Select The Data Source page of the Report Wizard now looks like this:

You can choose from seven connection types: Microsoft SQL Server, OLE DB, Microsoft 
SQL Server Analysis Services, Oracle, Open Database Connectivity (ODBC), XML, or 
Report Server Model. Once you select a connection type, you can type a connection 
string manually, or you can click Edit to use the Connection Properties dialog box to 
generate the connection string automatically. By default, the data source you create here 
will be available only to the current report, which allows you to manage its usage sepa-
rately from other reports. You can select the Make This A Shared Data Source check box 
at the bottom of the dialog box to allow this data source to be shared with other reports, 
which simplifies the management of data sources in general.
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3. Click Edit.

The Connection Properties dialog box is displayed. Because you selected Microsoft SQL 
Server as the connection type on the Select The Data Source page of the Report Wizard, 
the data source defaults to Microsoft SQL Server (SqlClient).

4. Type localhost or the name of the SQL Server instance that you are using in the Server 
Name box.

Note This book assumes that you have all Reporting Services components and SQL 
Server installed on one computer. In a real-world environment, there are advantages to 
using localhost instead of a SQL Server instance since you can easily reuse the data 
source when moving from development to production if everything is similarly con-
tained in a single machine. However, if you maintain separate instances of SQL Server, 
this strategy will not be useful.

5. Click Use Windows Authentication.

6. Select or enter rs2005sbsDW in the Select Or Enter A Database Name drop-down list.

The Connection Properties dialog box looks like this:

7. Click Test Connection to make sure you can connect to the rs2005sbsDW database, and 
then click OK to close the confirmation dialog box.

8. Click OK to close the Connection Properties dialog box.
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The current page of the Report Wizard looks like this:

Notice the connection string generated for your SQL Server data source: Data Source 
=localhost;Initial Catalog=rs2005sbsDW. Remember that you can also type in a con-
nection string for a data source, but it must use the syntax of the database to which 
Reporting Services will connect.

Now you have defined a data source that contains the information that Reporting 
Services needs to connect to the database it will use to retrieve data for your report. The 
data source includes a connection type, a connection string, and the credentials that will 
be used when the database is queried.

9. Click Credentials.

The Data Source Credentials dialog box is displayed:
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You can click the applicable option to override the authentication method you specified 
in the Connection Properties dialog box. Authentication methods include Windows 
Authentication, a single user’s credentials, a prompt at run time for the user’s credentials, 
or no credentials at all. (You’ll learn more about credential management in Chapter 9, 
“Managing Content.”)

10. Click Cancel.

11. Click Next.

Getting Data for the Report

In this next step of the Report Wizard, you design the query that will be displayed in the 
report. The query must conform to the relational database syntax you defined in the data 
source. You must get this query correct, or you won’t be able to continue with this wizard.

In this procedure, you’ll paste in a query that summarizes the Adventure Works sales for each 
employee by year, sales territory group, and sales territory country.

Design a query

1. Start Microsoft Notepad.

2. On the File menu, click Open.

3. Open the Sales Summary.txt file in the C:\Documents and Settings\<username>\My 
Documents\Microsoft Press\rs2005sbs\chap03 folder.

4. Copy the following query entirely:

SELECT 

   SUM(FactResellerSales.SalesAmount) AS ActualSales, 

   DimTime.CalendarYear, 

   DimSalesTerritory.SalesTerritoryGroup,  

   DimSalesTerritory.SalesTerritoryCountry, 

   DimEmployee.FirstName + ' ' + DimEmployee.LastName AS Employee 

FROM 

   FactResellerSales 

   INNER JOIN DimEmployee ON 

         FactResellerSales.EmployeeKey = DimEmployee.EmployeeKey 

   INNER JOIN DimTime ON 

         FactResellerSales.OrderDateKey = DimTime.TimeKey 

   INNER JOIN DimSalesTerritory ON 

         FactResellerSales.SalesTerritoryKey = DimSalesTerritory.SalesTerritoryKey          

AND  

         DimEmployee.SalesTerritoryKey = DimSalesTerritory.SalesTerritoryKey 

GROUP BY 

   DimTime.CalendarYear, 

   DimSalesTerritory.SalesTerritoryGroup, 

   DimSalesTerritory.SalesTerritoryCountry, 

   DimEmployee.FirstName + ' ' + DimEmployee.LastName
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5. Paste the copied query into the Query String box on the Design The Query page of the 
Report Wizard.

Now the current page of the Report Wizard looks like this:

Note Instead of typing or pasting in a query string, you can also click Query Builder to 
open the Query Builder to create a SELECT statement using a graphical interface. If 
you’ve used the Query Builder in SQL Server 2000 Enterprise Manager or the Query 
Designer in Microsoft SQL Server Management Studio for SQL Server 2005, you’ll be in 
familiar territory. If you haven’t used either of these applications, you can learn more 
about the Query Builder in Chapter 7.

This query will be used to retrieve data from the defined data source for use in your 
report. The format of the query depends on the data source you selected. For this pro-
cedure, because you selected a Microsoft SQL Server data source, you use Transact-SQL 
to build your query. 

The query that you create is just one of several items stored in a dataset. As you learned 
earlier in this chapter, a dataset is a container for a pointer to the data source and the 
query you design. (You’ll learn more about designing queries to create a dataset in 
Chapter 4.) In general, you can type a query directly into the Query String box, use the 
Query Builder button to open the Query Builder, or paste in a query that has been tested 
first in Query Analyzer or saved in a file. 

6. Click Next.

When you click Next, the query is validated against the data source. If there is any prob-
lem, such as an invalid column name, an error message will be displayed in the bottom 
section of the Design the Query page. You will not be able to continue past this page of 
the wizard until you correct the error.
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Structuring Data in the Report

After defining the data source and the dataset, you’re ready to move on to design consider-
ations. Now you select a report type that defines how the data is structured in the report. In 
the wizard, you can choose between a tabular or a matrix report type only. You also arrange 
the data within the selected structure and finish the design by applying a style template. These 
steps make it easy to create a nice-looking report without a lot of effort, but you’ll still have an 
opportunity to make adjustments to the layout and style before you publish the report.

In this procedure, you’ll select the tabular report type for your report.

Choose a report type

Click Tabular.

1. The Report Wizard page looks like this:

Notice that the Finish button is now enabled. You have, at this point, created a basic report 
that is ready for publishing. Now you can decide how you want to proceed. You could click 
Finish and make any desired modifications using the Report Designer. However, to find out 
everything you can do with this tool, you’ll continue designing your report with the wizard.

The report type defines the structure, or data region, of the data that is returned by the 
query you design. The Report Wizard allows you to present this information as either a 
table or a matrix. (You do have more options, but the Report Wizard limits you to these 
two data regions, referred to as report types in the wizard.) The main difference between 
these two types of data regions is the number of columns. A table has a fixed number of 
columns, whereas a matrix has a variable number of columns that is determined by the 
query results. You’ll find more information about these and other data regions in Chap-
ter 6, “Organizing Data in Reports.”

2. Click Next.
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Placing Data in the Report Structure

In this step of the Report Wizard, you arrange the data within the report type that you 
selected. This process determines how data is grouped and the order in which it is displayed. 
You can think of grouped data as the vertical sections of a report (although groups can be dis-
played next to each other), and the data order as the sequence in which the data is presented 
in the same row—vertically for groups and horizontally for columns.

In this procedure, you’ll arrange the five fields produced by the query to build a report that dis-
plays the ActualSales amount for each Employee as detail rows, in groups by SalesTerritoryGroup 
and SalesTerritoryCountry, with a page break for each CalendarYear.

Arrange data on the report

1. Click CalendarYear, and then click Page to place the CalendarYear field in the Page sec-
tion of the Displayed Fields list.

The Report Wizard looks like this:

When you place a field in a display section, the corresponding section in the sample 
table is highlighted to show you where the field will appear in your report. Each column 
of data returned by the query is linked, or mapped, to a report field that is displayed in 
the Available Fields list until assigned to a section of the data region. When assigned to 
a data region’s section, the report fields appear in the Displayed Fields list. The section 
to which you assign the field determines whether you see detail rows, aggregated rows, 
or both types of rows in the report. Assignment of fields to data regions and the use of 
aggregations are discussed more thoroughly in Chapter 4 and Chapter 5, “Working with 
Expressions.”

Because you are using a tabular report type, you can assign fields to the page, group, or 
details section of the report. For example, a field assigned to the page section will not be 
included in the table in the report, but will instead be placed in a textbox positioned at 
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the top-left corner of the report. Each distinct value for a page field creates a page break 
in the report. Fields added to the group section of the report are used to break the table 
into separate sections, which can include subtotals by section. 

The table rows are built from the values for the fields assigned to the details section of 
the report. There is one table row for each row returned by the defined query. A numeric 
field in the details section is summed up into the subtotals if you select the option to 
include subtotals. You can decide later whether you want to hide the details in the 
report if you prefer to display just summary information.

Note If you choose a matrix report type, the field assignment is slightly different. The 
wizard still includes the page and details sections, but the group section is replaced by 
sections for columns and rows. You’ll need to assign at least one field to each of these 
sections to build a matrix, which is also known as a crosstab. Matrix reports are covered 
in Chapter 6.

2. Click SalesTerritoryGroup, and then click Group to place the field in the Group section. 
Repeat for SalesTerritoryCountry. Alternatively, you can use the drag-and-drop feature to 
move a field from the list of available fields to the appropriate section.

The order in which you add fields to each section determines the sequence in which the 
data is displayed in the report. The fields in the Group section will be displayed in order 
from top to bottom or from left to right, depending on the style template that you select 
in a later step in the wizard. Fields in the Details section will be displayed in columns in 
order from left to right.

3. Drag ActualSales to the Details section, which is the bottom section of the Displayed 
Fields list, and then drag Employee to the same section.

The Design The Table page of the Report Wizard looks like this:
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Tip Even after the fields are placed into the Displayed Fields list, you can still rearrange 
them to affect their order in the respective sections.

If you had selected the Matrix option on the previous page, Select the Report Type, you 
would see the Design the Matrix page here instead of the Design The Table page.

4. Click Employee, and then click the Up button to move Employee above ActualSales. You 
can also drag and drop to rearrange fields within a data region.

Now the page looks like this:

5. Click Next.

Applying a Style Template

In this step of the Report Wizard, you make your last design decision for your report. When 
you apply a style template, you define the look and feel of the report.

In this procedure, you’ll define a block layout for the table, which includes group subtotals, 
and select the Bold style template.

Select a report style

1. Select Block.

Note This page of the wizard will not be displayed if you selected a matrix report type.
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Notice that the sample layout changes to give you a preview of the block layout. Here, 
you are choosing a layout style for the tabular report that controls the placement of 
detail rows relative to aggregated rows on the report. You can also choose to include sub-
totals or enable drilldown. The difference between the layout options will become 
clearer when you can actually view your report. At that time, you’ll see examples of the 
other layout styles for comparison.

On this page of the Report Wizard, you must select either a stepped or block report lay-
out style. In a stepped layout, each distinct group value is arranged on its own row and 
in its own column. The drilldown option (which displays hidden detail data) is available 
only for stepped layout. By contrast, the block layout is more compact—you place data in 
each column and start a new row only for additional detail rows within the same group 
or for a new group value. 

2. Select the Include Subtotals check box to include subtotals in your report.

3. Click Next.

4. Click each table style to preview the style in the Choose The Table Style page.

The assignment of a style template to a tabular or matrix report sets the overall color 
theme and font usage for the report.

5. Click Bold to set the style for your report.

6. Click Next.

Finishing the Report Wizard

You’re almost finished building your report by using the wizard. You’ve defined where to find 
the data, what data to include in the report, and how the data will look in the report. All that 
remains is to specify a location on the Report Server that will be the ultimate destination of 
your report when it is published and to give your report a name. You also have an opportunity 
to review a summary of the selections that you made throughout the wizard and to proceed to 
a preview of your report.

In this procedure, you’ll provide the URL for your local Report Server, specify the Adventure 
Works folder for deployment, and name your report. When you’re finished with the wizard, 
you will be able to preview the report.
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Set report and project properties

1. Confirm that the current page of the Report Wizard looks like this:

The deployment location is a URL for the Report Server that will host the report as well 
as the folder into which the report will be placed on the server. This step of the Report 
Wizard simply sets the project properties and does not actually deploy, or publish, the 
report to the Report Server. Notice that the default folder has the same name as your 
project. If this folder does not already exist, the folder will be created when you deploy 
the report. Otherwise, the report will be deployed to the existing folder. 

Important The server name will not be validated in this step. If you enter an incorrect 
server name, deployment fails. You can update the project properties in the Solution 
Explorer if this occurs. You’ll learn how to do this in Chapter 9.

2. Click Next.

3. Type Sales Summary in the Report Name box.

Important If you use the name of a report that has already been deployed to the 
Report Server, you will overwrite the published report during deployment of the 
report in Visual Studio—but only if you deploy the report to the same folder as the 
existing folder. There will be no warning message during deployment that you are 
about to overwrite an existing report, so be careful when assigning names and folder 
locations to reports.

4. Scroll through the information in the Report Summary box to review your selections.

5. Select the Preview Report check box to preview your report.
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The final page of the Report Wizard now looks like this:

At the completion of the Report Wizard, you can immediately preview the report. Some-
times you might prefer to make some additional changes to the report before you display 
the preview. If you do not select the Preview Report check box, the Report Designer dis-
plays your report in layout mode. If the report is in layout mode, you can easily switch to 
preview mode by clicking the Preview tab in the Report Designer.

Tip An important reason to preview the report is to check the size of the columns. The 
columns will all default to the same size and will probably not be wide enough for data. 
Also, you might need to adjust formatting for numeric values. You can fix these problems 
using the layout mode, and then review the fixes using the preview mode.

6. Click Finish.

Checking the Report Layout

When you finish designing your report, you need to preview it to check the layout and make 
some corrections to improve its appearance. You also need to make sure you get the data you 
expected and that the data is formatted correctly. When you finish making any necessary cor-
rections, you wrap up this authoring stage of the reporting life cycle by publishing the report 
to the Report Server, where it can be accessed by the users. 

In this procedure, you’ll explore your report in preview mode so you can see the results of the 
selections you made in the Report Wizard.
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Preview a report

1. If you selected the check box to preview the report on the last page of the Report Wiz-
ard, you will see your report in preview mode. If not, just click the Preview tab in the 
Report Designer.

When you display a report in preview mode, the query is executed and the query results 
are stored in a dataset and assigned to fields. The report is then rendered according to 
the assignment of the fields to data regions that you specified as well as the layout and 
style that you selected. At this point, the report format and the report data are merged to 
produce the preview that you can see in the Report Designer. In preview mode, you can 
interact with the report just as if it were published to the server so you can test the 
results before making it available on the Report Server.

Your screen now looks like this:

Take a moment to review the layout of the data in the report. The CalendarYear field is 
displayed in the top-left corner. Just below the CalendarYear, you can see the column 
names in the table header with the details displayed in rows by groups. The first group 
is SalesTerritoryGroup, and the second group is SalesTerritoryCountry. Because these 
fields are defined as groups, their values are displayed only in the first row of details 
within that group. In the example, you can see actual sales amounts for employees in 
Canada which is grouped in North America. The row beneath these details is the group 
subtotal for Canada.

Once you’ve closed the wizard, you can’t return to it to make layout changes. Instead, 
you must create a new report, which you may find easier to do than making changes to 
the layout directly in the Report Designer. If you were to use the wizard to create a 
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stepped report with subtotals (on the Choose The Table Layout page) using the same 
query, then the report would look like this: 

Notice that North America is now in its own row, and its subtotal is included on the 
same row. Then Canada appears by itself on the next row, followed by the detail rows. 
This report style is longer than the block layout.

If you had instead used the wizard to create a report with a stepped layout with drill-
down selected, the report—with North America and Canada expanded to show the 
detail rows—would look like this:

With drilldown, the user can click the plus sign to expand the report and click the 
minus sign to collapse the report at will. By default, the report is completely collapsed 
when it is opened.
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2. Scroll down to the bottom of the first page. Notice the group subtotal for United States. 
Beneath this group subtotal, you can see the group subtotal for SalesTerritoryGroup, 
which is the subtotal for Canada and the United States.

3. Click the Next Page button on the Preview toolbar to view the page for 2002.

Since you assigned CalendarYear to the Page data region of the report, each page con-
tains data for a separate year. You can use the page buttons on the Preview toolbar to 
navigate between pages, or you can type in the page number that you want to view as 
shown here:

4. Scroll to the bottom of the second page to see the layout when there are multiple values 
for SalesTerritoryGroup, then scroll back to the top of the page.

5. If you can’t see the full width of the report, scroll horizontally to see the Actual Sales 
column.

The top of your report looks like this:

Notice that the text is wrapping in several columns: SalesTerritoryCountry, Employee, 
and ActualSales. If you are trying to fit many columns onto a printed page, you may need 
to use text wrapping to fit a table within the available horizontal space. However, for 
online viewing, you generally have more room available and you can minimize vertical 
scrolling for the user if you widen each column to accommodate the maximum expected 
string length. In addition, the format of the ActualSales values can be improved.

6-2250-7.book  Page 54  Tuesday, March 21, 2006  3:45 PM



Chapter 3: Building Your First Report 55

Correcting Report Layout Issues

Preview mode in Report Designer allows you to see where you need to clean up your report, 
but you need to switch to layout mode in order to fix the problems. In layout mode, you can 
adjust every property of every element in the report, giving you complete control over every-
thing that you can see. You can easily switch back and forth to test the results of your changes 
to the report in layout mode.

In this procedure, you’ll use layout mode to improve the appearance of the report and check 
the results by again previewing the report.

Fix column sizes and data formatting in the report layout

1. Click the Layout tab.

The report is displayed in layout mode:

Notice the rulers that appear both above and to the left of the report layout. You can use 
these rulers as a visual guide when making changes to the report, such as when resizing 
report items or positioning new report items.

2. Click any cell in the table to display the column and row handles.

The table now looks like this:
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The column handles are the shaded cells that appear above the table, and the row han-
dles are the shaded cells with icons that are shown to the left of the table. You use these 
handles to modify the table properties.

3. Position your cursor between the second and third column handles, and then click and 
drag to widen the second column, Sales Territory Country, to approximately 1.5 inches.

Now the table looks like this:

You can drag the column only when the cursor is properly positioned and the cursor 
changes to a double-headed arrow. Making the column bigger eliminates the text wrap-
ping problem, but it also requires you to have some idea of the maximum length of the 
data that could appear in that column.

4. Position the cursor between the third and fourth column handles, and then click and 
drag to widen the Employee column to approximately 1.75 inches.

5. Right-click the fourth column handle, above Actual Sales, to select the entire column, 
and then click Properties.

The Properties window for the selected column, named TableColumn4, is displayed in 
Visual Studio:

6-2250-7.book  Page 56  Tuesday, March 21, 2006  3:45 PM



Chapter 3: Building Your First Report 57

6. Scroll through the Properties window, if necessary, to find the Format property, and 
then type C0 in the Format property field to format the field as currency with no decimal 
places.

Note Use .NET formatting strings to control the data display. You can find more infor-
mation about formatting numeric strings online at http://msdn.microsoft.com/library
/default.asp?url=/library/en-us/cpguide/html/cpconstandardnumericformatstrings.asp. 
Information about formatting date strings is located at http://msdn.microsoft.com
/library/default.asp?url=/library/en-us/cpguide/html/cpconDateTimeFormatStrings.asp.

Scroll to the bottom of the Properties window to find the Width property, and then type 
1.25in to resize this column.

You can provide a specific measurement for the Width property when you require more 
granular control over the size of a column.

Click the Preview tab to preview the modified report.

The newly formatted report is displayed:

The text wrapping problem is solved, and the format of the Actual Sales column is 
improved. Your first report is ready for publishing!  

Publishing a Report

Now you’ll wrap up the authoring stage of the reporting life cycle by publishing the report to 
the Report Server, where it can be accessed by the user community. 

In this procedure, you’ll deploy a report solution that enables you to publish your report to 
your local Report Server.
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Deploy a report solution

1. On the File menu, click Save All.

2. In the Solution Explorer window, right-click the Adventure Works project at the top of 
the tree, and then click Properties.

The Adventure Works Property Pages dialog box is displayed. You can see the Target
ReportFolder and TargetServerURL properties for which values were provided on the 
Choose The Deployment Location page of the Report Wizard.

3. Click Configuration Manager.

4. Verify that the Deploy check box is selected.

The Configuration Manager dialog box looks like this:

5. Click Close, and then click OK.

6. On the Build menu, click Deploy Adventure Works.

The Output window displays the progress of deployment. Deployment of the solution is 
complete when you see messages in the Output window announcing that the build and 
deploy operations succeeded:

Instead of deploying an entire solution, you also have the option to deploy a single 
report or multiple reports within a project or solution. A report is published by using 
one of these deployment options to transfer it from Visual Studio to the Report Server. 
You can alternatively publish a report programmatically using a script or manually using 
the Web application called Report Manager, which you’ll learn about in Chapter 9.
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Managing a Report 
You can manage published reports by using Report Manager, which is supplied by Reporting 
Services. Management of reports includes such activities as setting report properties and exe-
cution properties, managing content in folders, and applying security on the Report Server to 
control how users access and interact with reports. You perform only a few management tasks 
in this chapter. (You’ll learn about all the management tasks in Part III, “Managing the Report 
Server.”)  

Reviewing Report Properties

Each report has a set of properties pages that you must manage. You need to know how to use 
the Report Manager to find these properties and to review the types of properties you can 
manage. 

In this procedure, you’ll navigate from the Home page of Report Manager to the Properties 
page of your report.

Open the report’s Properties page

1. Open Internet Explorer.

2. Type the URL http://localhost/Reports to open the Report Manager.

The Home page of Report Manager is displayed:

3. Click the Adventure Works folder link.
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The folder contents are displayed:

Notice that this page has a Properties tab in addition to the Contents tab. (You’ll learn 
more about managing folder properties in Chapter 9.) Currently, the Adventure Works 
folder contains only one report, the Sales Summary report that you just published. 

4. Click the Sales Summary link.

Reporting Services generates and displays the Sales Summary report:
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The View tab is displayed by default when you open a report. Three other tabs are avail-
able for this report: Properties, History, and Subscriptions. In this section, you review 
the Properties page. Later, in Chapter 7, you’ll learn more about the other tabs.

Tip You don’t have to wait for the report to be displayed before clicking another tab.

5. Click the Properties tab.

The Properties page for the Sales Summary report is displayed:

On this page, you can see the author and also the date the report was created. The mod-
ification author and date of modification match creation information until the report is 
subsequently modified. Notice that you can change the name of the report on this page 
and add a description. The other tasks that you can perform on this page are covered 
later in Chapter 9.

Notice the links in the left frame of the browser window. The many types of report prop-
erties are logically organized into separate pages, where you can apply changes to cur-
rent settings. Properties determine, for example, how the report appears in Report 
Manager, how users can interact with the report, and how the Report Server connects to 
the data sources. You’ll review report properties in greater detail in Chapter 9. 
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Changing Report Properties

Often, you will want to add a description so a user knows what your report contains before 
opening it. This property is accessible on the main properties page of the report.

In this procedure, you’ll add a description and observe how a description is displayed on the 
Contents page of a folder.

Add a description

1. In the Description box, type Actual sales by year, territory, and salesperson.

Your screen looks like this:

This report description is displayed on the Contents page and, importantly, is visible 
only to users who have been granted permission to view the report.

2. Click Apply.

Clicking Apply doesn’t appear to change anything. However, the report description is 
now visible on the Contents page of the Adventure Works folder.

3. Click the Adventure Works folder link at the top-left corner of the browser window.

6-2250-7.book  Page 62  Tuesday, March 21, 2006  3:45 PM



Chapter 3: Building Your First Report 63

Your screen looks like this:

Notice how the report description is displayed below the report name.

Reviewing Execution Properties

Execution properties are a subset of the report properties maintained for each report. When 
you understand the implications of the execution property settings, you can choose the most 
appropriate property setting for your reporting environment. Execution properties allow you 
to manage reports by balancing system resources and performance with the users’ informa-
tion requirements. For example, you set up caching to achieve a reasonable balance when data 
used in the report is not changing rapidly at the source. To use caching, you first need to 
change the data sources properties so you can assign logon credentials that will be used to 
execute the report for the cache. Separate logon credentials are required by Reporting Services 
to implement report caching in order to make a single report available to many users.

In this procedure, you’ll open the Execution Properties page for your report to review the 
available options.

Open the report’s Execution Properties page

1. Click the Sales Summary link.

Assume for a moment that you’ve just started a new browser session. Just like the previ-
ous time you opened this report, a message is displayed to let you know that several 
activities are occurring: “Report is being generated”. Each time a report executes on 
demand, as you initiated in this step, a query is executed to retrieve data from the 
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rs2005sbsDW database. The data is processed with the report, which is then rendered 
into the HTML display in your browser window. 

2. Click the Properties tab.

3. Click the Execution link in the left frame of the page.

The Execution Properties page is displayed:

Notice that you can render the report either on demand or on a scheduled basis. When 
rendered on demand, the report typically displays the most recent data and may or may 
not use caching. By default, a report renders on demand without caching. When ren-
dered on a scheduled basis, the report is stored as an execution snapshot, which cap-
tures data for the report at a point in time. 

Execution properties control when report processing occurs. When a report executes on 
demand, which occurs every time another user opens the report, the defined query runs 
and the query results are merged with the report definition to produce the HTML out-
put format. You can alternatively set the execution properties to process the report at a 
scheduled time so the report is ready when accessed. However, if you choose to do this, 
let users know that the data in the report is not current. Another option is to cache a 
report temporarily to make the same output available to several users for the duration of 
a specified timeframe. The key difference between a snapshot and a cached report is that 
the snapshot is stored permanently until physically deleted, while the cache is stored 
temporarily with a predetermined expiration. The options for specifying execution 
properties are covered in Chapter 9. 
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Changing Data Sources Properties

Data sources properties define the connection to be used for query execution. You can change 
these properties to override the credentials used for authentication when the report executes. 
Queries that run unattended, such as when a report is cached or scheduled for execution, 
require stored credentials. These credentials are encrypted when stored in the ReportServer 
database. (You’ll learn more about using secured credentials in Chapter 9.) To set up a cache 
for your report, you need to change the credentials information in the data sources properties.

Use secured credentials

1. Click the Data Sources link in the left frame of the page.

2. Click the Credentials Stored Securely In The Report Server option.

3. Type ReportExecution as the user name.

This SQL Server login was added when you installed the sample databases.

4. Type ReportExecution as the password.

Important In a production environment in which you are using stored credentials, it’s 
important to test the report by viewing it to ensure that you have entered the user name 
and password correctly. The credentials will not be validated until the report executes.

Your screen now looks like this:

5. Click Apply.

6-2250-7.book  Page 65  Tuesday, March 21, 2006  3:45 PM



66 Part I: Getting Started with Reporting Services

Changing Execution Properties

You might want to temporarily cache a report to improve performance. When a user first 
opens the report, a copy of the report is placed in temporary storage and made available to 
other users who open the same report. You can also assign a time limit for the cache so that 
the report can be periodically refreshed with more current data.

Note The type of caching discussed in this chapter refers to the access of a single report by 
multiple users. When you open a report, the report is automatically cached for you as part of 
your browser session. You can then return to this report repeatedly during the same session 
without having to wait for the query to execute again, regardless of the current setting of the 
report’s execution properties. When you close the browser window, the report is removed from 
this cache. You’ll learn more about session caching in Chapter 9.

In this procedure, you’ll change the report execution properties to cache your report, and set 
the cache to expire after 60 minutes.

Define a report cache

1. Click the Execution link.

2. Click the Cache A Temporary Copy Of The Report. Expire Copy Of Report After A Num-
ber Of Minutes option to cache the report and expire after a specified number of min-
utes. Change the number of minutes to 60.

Your screen looks like this:
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3. Click Apply at the bottom of the page.

The next time this report is opened, a temporary copy of it will be placed in the cache to 
speed up its display for any later requests by other users within the same hour. At the 
end of 60 minutes, the temporary copy is removed from the cache. A new copy is only 
placed in the cache when a user requests the report again.

As mentioned earlier, by using the caching option, you can improve performance for 
the next user who opens the same report. Any subsequent request for a report results 
in the display of the cached copy of the report rather than in the execution of the 
query and processing of the report. That is, any subsequent request displays the 
cached report until the cache expires. The purpose of expiring the cache on a periodic 
basis is to force the report to be refreshed with the most current data when the next 
user accesses the report. The result is a new cached instance of the report until the 
next scheduled expiration.

Tip The caching feature is useful when you have a query that takes a few minutes or 
more to execute and many people want to see the same report. It minimizes the 
demand for resources on the database server, reduces the level of network traffic asso-
ciated with transporting the data from the database server to the Report Server, and 
speeds up the display of reports when requested. For more details about report cach-
ing, refer to Chapter 9.

Accessing a Report
Each published report has its own URL on the Report Server. Instead of using the Report 
Manager to navigate through folders to find a report, you can enter the report’s URL address 
into your browser. You can also use this URL in a hyperlink that you add to a custom HTML 
page. (In fact, you could even include additional characters in the URL to control the behavior 
of the report, such as formatting the report with a different rendering extension, but you’ll 
learn how to do that in Chapter 18, “Building Custom Reporting Tools.”) For now, it’s easiest 
to use the Report Manager to find and view a report online and to export the report to another 
format.

Displaying a Report

Now that you successfully authored and managed your report, you are ready for the access 
stage of the reporting life cycle. When you access a report online, you can use a toolbar in the 
viewer to help you explore your report. After opening the report, you can navigate through its 
pages or search for specific text so you can jump forward in it.

In this procedure, you’ll explore each page of your report.
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View report pages

1. Click the View tab.

The first page of the report, for calendar year 2001, is displayed. This presentation of the 
report is nearly identical to the version you saw in the Report Designer. You now have 
the HTML viewer that includes a report toolbar to help you explore and interact with 
the report. For example, you can use controls in the toolbar to page through the report, 
to search for a string in the report, or to export the report to another format. The HTML 
Viewer is covered in more detail in Chapter 12, “Accessing Reports.”

2. Click the Next Page button on the View toolbar to view the sales data for each year.

Searching a Report

Sometimes the information you’re looking for can be difficult to find in a lengthy or multipage 
report. The HTML Viewer provides a feature to help you find a text string anywhere in the 
report, from your current position to the end of the report.

In this procedure, you’ll use the search feature to locate specific text in the report.

Find text in a report

1. In the Find text box, located in the center of the View toolbar, type Linda. Click the Find 
link.

Your screen looks like this:

The Find link is not enabled until you type a string into the associated search box. When 
you click this link, the report scrolls to the first occurrence of this string in the report. 
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2. Use the Next link to find the next occurrence of the string. 

The search operation begins in the currently selected page or section and continues 
across each page of the report until the end of the report is reached.

Tip You don’t need to worry about using the correct case, because the search opera-
tion is not case-sensitive. However, you are limited to a string length of 256 characters. 

Exporting a Report

The HTML format is not the only format you can use to view your report. You can also export 
the report to another format that allows you to create a file that you can open immediately or 
save to your computer. The View toolbar includes a drop-down list from which you can 
choose an export format. (Reporting Services includes several export formats, also referred to 
as rendering formats, which you’ll review more closely in Chapter 13, “Rendering Reports.”) 
This feature gives you the flexibility to produce several versions of your report from a single 
platform.

In this procedure, you’ll complete your tour of Reporting Services by exporting your report to 
an Excel format, opening the generated Excel workbook, and examining each sheet in the 
workbook, comparing them with the rendering of your report as HTML.

Export to Excel

1. Click Excel in the drop-down list at the far right of the View toolbar.

Your screen now looks like this:
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As mentioned earlier, the Export feature of the HTML view gives you the ability to view 
the report in a different format. When you export the report, if a viewer is available for 
the selected format, a new browser window opens. For example, to export to the Excel 
format, you must have Microsoft Excel installed on your computer.

2. Click the Export link.

A new browser window opens and the File Download dialog box is displayed:

You can open the file to view it now, or you can save the file to view it later.

3. Click Open.

The Report Server renders the report as an Excel file that downloads to your computer. 
Microsoft Excel opens, and the report is displayed:
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Notice that the report style in Reporting Services is closely reproduced in the Excel ver-
sion of the report. Much of the color style, font style, and layout that you see in the 
HTML version of the report also appears in the Excel version. Each page has been 
placed on a separate worksheet in the Excel workbook.

4. Click each worksheet tab to review the sales data for each year.

With the report in this format, you can take advantage of all of Excel’s features to inter-
act with the report data and perform additional analysis that was not possible using the 
static report in the browser.

Chapter 3 Quick Reference

To Do this

Start the Report Server Project 
Wizard

Start a new project in Visual Studio (SQL Server Business Intelligence 
Development Studio) and select Report Server Project Wizard from the 
Business Intelligence Projects folder. You must provide a name for the 
project and solution and designate a folder location for the solution.

Add a data source using the Report 
Wizard

On the Select The Data Source page, enter a name for the data source; 
select a connection type; and enter a connection string, or use the Edit 
button to access the Connection Properties dialog box to generate the 
connection string automatically. For example:

Data Source=localhost;Initial Catalog=rs2005sbsDW 

Add a query string using the 
Report Wizard

On the Design The Query page, enter or paste in a query string, or click 
the Query Builder button to open the Query Builder.

Select a report type using the 
Report Wizard

On the Select The Report Type page, click either the Tabular or Matrix 
option.

Arrange the data using the 
Report Wizard

On the Design The Table page, assign fields to the Page, Group, and 
Details sections.

In the Design The Matrix page, assign fields to the Page, Columns, 
Rows, and Details sections.

Select a table layout using the 
Report Wizard

On the Choose The Table Layout page, select Block or Stepped, or op-
tionally include subtotals. If you choose the stepped layout, you can en-
able drilldown.

Apply a style template using 
the Report Wizard

On the Choose The Table Style page or the Choose The Matrix Style 
page, click a style name. 

Assign a deployment location 
and a report name using the 
Report Wizard

On the Choose The Deployment Location page, enter the URL for the 
Report Server to host the report. For example: 
http://localhost/ReportServer

Optionally, enter a folder name. The folder will be created on deploy-
ment if it does not already exist.

The final page of the Report Wizard requires a report name.

Preview a report In Visual Studio, click the Preview tab.
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Adjust the size of a column in 
a table

In Visual Studio, click the table to display the column and row handles, 
and then drag the column handle to the left to make the column small-
er or to the right to make it larger. Alternatively, set the Width property 
for the selected column.

Publish a report solution On the Build menu of Visual Studio, click Deploy projectname.

Open Report Manager Enter the URL in your browser. For example:

http://localhost/Reports.

View a report In Report Manager, navigate the folder hierarchy to the report, and 
then click the report link.

Manage report properties With the report open in Report Manager, click the Properties tab. Use 
the applicable link in the left frame to access the set of properties to be 
managed. Set a property by clicking an option or selecting a check box, 
and then clicking the Apply button.

Export a report With the report open in Report Manager, select the export format from 
the list box and click the Export link.

To Do this
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